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Introduction

T Please read the Getting Started Guide, which will help you customise SMART Estimator before
[ - continuing to read this guide.

Note on TG20:21

X .-:? On 12t April 2021, the National Access and Scaffolding Confederation (NASC) launched the new
s TG20:21 guidance. https://eportal.nasc.org.uk/tg20

In due course, SMART Estimator will be updated to support the new guidance with a Check IT
TG20:21 module. This guide only relates to the TG20:13 check.

Thank you for choosing SMART Estimator.

» This user guide explains how to use the Check IT TG20:13 and Check IT TG20:13 Plus features
of SMART Estimator. SMART Estimator Check IT TG20:13 supports your work within TG20:13,
published by the National Access and Scaffolding Confederation (NASC). TG20:13 is a guide to
good practice for tube-and-fitting and system scaffolding.

» SMART Estimator Check IT TG20:13 simplifies the design process by automatically checking
your scaffold against TG20 criteria while you work. SMART Estimator conforms to TG20:13 by
creating drawings and load lists that comply with the TG20:13 bracing patterns, and by using
the TG20:13 tie rules to estimate the number of ties required for a scaffold.

» SMART Estimator Check IT TG20:13 Plus provides TG20:13 certificates for scaffolds that pass
the check. Certificates can be used as proof that your scaffolding is exempt from design, as it
will be erected in accordance with TG20:13.

“Any proposed modification or alteration that takes a scaffold outside the scope of a generally recognised
standard configuration should be designed by a competent person and proven by calculation.”

http://www.hse.gov.uk/construction/scaffoldinginfo.htm

“Our mission is to prevent death, injury, and ill-health in Great Britain’s working places.”

CA_DS 1 Copyright 2024 © Computer and Design Services Limited
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Check IT TG20:13 Plus

Check IT TG20:13 Plus provides printable,
exportable compliance certificates. These
certifcates act as proof that your scaffolds are
TG20:13 compliant and are therefore exempt
from structural design.

Check IT TG20:13 user guide

Check IT TG20:13

Check IT TG20:13 summarises, in a printable and
exportable format, which of your project scaffolds
are compliant scaffolds, which are not and thus may
require design, and it offers suggestions and
guidance on how to make your project compliant.
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SMART Estimator Check IT TG20:13 benefits

SMART Estimator Check IT TG20:13 has been designed to help your business adopt TG20:13 and cost-
effectively meet the requirements of the HSE.

v SMART Estimator Check IT TG20:13 will summarise whether your scaffolds are
TG20:13 compliant and are therefore exempt from a structural design

Quickly generates a printable and exportable TG20:13 summary report that can
v be used to confirm that you will be able to obtain a NASC TG20:13 compliance
sheet (available from the NASC TG20:13 eGuide or Operational Guide)

v Helps you to learn TG20:13 as you work, bringing the text of TG20:13 to life with
graphics and easy-to-understand compliance summaries and guidance

SMART Estimator Check IT TG20:13 helps you to adopt TG20:13 as easily as
v possible, get the most value from it, and save you time and money by avoiding
the need for an engineering design for everyday scaffolding

SMART Estimator keeps up with the latest changes to TG20, helping you to
v understand the impact of the changes and to ensure that you continue to
conform to the requirements of the HSE

v SMART Estimator offers easy to follow suggestions and guidance for non-
compliant scaffolds avoiding accidental non-compliance

CA_DS 3 Copyright 2024 © Computer and Design Services Limited
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Introducing TG20:13

TG20:13 is a Technical Guidance document published by
the NASC - the National Access and Scaffolding
Confederation — who are the UK national trade body for
access scaffolding.

It was developed by the NASC in response to changing
European legislation, which requires every scaffold to be
designed by calculation. It would not be practical for every
scaffold to be individually designed by an engineer, so
TG20:13 aims to solve this problem with its standard
scaffold system.

TG20:13 contains a set of definitions for standard

scaffolds that have been designed by the NASC: if a scaffold matches one of the standard scaffold
definitions then the design from TG20:13 can be reused; if the scaffold does not match any of the
standard scaffold definitions then it may require design advice from a structural engineer.

TG20:13 is supplied in four volumes:

» Operational Guide: gives guidance on TG20:13 to scaffolding operatives;

» User Guide: a quick pocket size reference guide to TG20:13 for a scaffolding operative;

» Design Guide: gives guidance on TG20:13 for scaffold designers, with greater detail on

compliance;

» E-Guide: a digital version of the guide which can check individual scaffolds for compliance.

SMART Estimator Check IT TG20:13 helps you to get the most from TG20:

v/ It will summarise TG20:13 compliance for multiple scaffold models
simultaneously, showing whether your scaffolds are compliant;

- "’ v/ It produces a printable report summarising which of your scaffolds need a design;

It will help you to learn how TG20:13 works;

It will help you identify and resolve non-compliant scaffolds, by offering guidance

and suggestions.

CADS
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Checking TG20:13 compliance

To activate the TG20:13 compliance check features, select the Check IT TG20:13 tab.

Schedule IT BIM Toolbox Model IT Check IT TG20:13 Report IT Price IT Quote IT Configuration

This module helps you to summarise TG20:13 compliance in four simple steps:

Set the Wind Factor;

|3In This tool determines the effect of the wind on your scaffold.
Wind Eactor S ':’ If you already chose a site address with a UK postcode when you first
sV
- = created the project, this will already be set for you.

- Set the Fagade Type;
Specify whether your scaffold is Permeable or Impermeable (tied to a fagade with

Facade .
Type ~ openings or not).
[}

ﬁ Set the Loading;

Loading Specify how much load your scaffold needs to support.
Run the final summary report to review your scaffolds TG20:13 compliance.

TG20:13

Chedk

CA.DS 5 Copyright 2024 © Computer and Design Services Limited
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Wind factor

The site Wind Factor is essential to determine the maximum safe height of the scaffold, particularly
where sheeting or debris netting are used.

There are four methods for setting the Wind Factor, dependent on your internet connection
availability. Choose one of the below:

A. You can enter the site address including a UK postcode;

You can enter the UK postcode of the site where the scaffold will be erected,;

¢ _\«’ If you already chose a site address with a UK postcode when you first
Q; created the project, this will already be set for you. You can move to the
- next step.
C. You can select a map location and manually enter the Topography and Seasonal Factors.

CA_DS 6 Copyright 2024 © Computer and Design Services Limited
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Choose ONE of the following to set the Wind Factor:

A: Using a UK site address with a UK postcode

» Click the arrow located beneath the Wind Factor image, avoiding selecting the top half (which
has an image, but no text);

> Select the Set the Site Address button;

. 9 a8
Site I
;J Group :
CADS -
MName :
CADS

Business Address :
Arrowsmith Court

Town : County :
Broadstone Dorset

Country : Postcode :
UK BH18 BAX

» Enter the site address and click the green Apply tick button;

B: Using a UK postcode

» Click the arrow located beneath the Wind Factor image, avoiding selecting the top half (which
has an image, but no text);

Type the postcode into the text box which appears;

Click the Lookup button or press Enter;

If the postcode is successfully recognised a tick will be displayed and the Wind Factor will be
set.

Site Address

& Look up posteode:  BH18 8AX Lookup

c_A_DS 7 Copyright 2024 © Computer and Design Services Limited
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C: Usingamap

j _‘;\
ﬂ 1d minimum required tie duty based on the wind conditions

{ factor used by the TG20 chedks.

Click the Wind Factor image;

Using the mouse, left click the red marker and hold down the mouse button
whilst you drag the marker to your location;

» Click on the image in the centre dial, ‘TG20 Topography’ to change your
landscape (for details, see the NASC TG20:13 Operational Guide);

» For non-flat topography, move the small marker to your site location on the
topography feature;

> Update the Seasonal Factor by left clicking the mouse in the centre of the
Seasonal Factor dial (for details, see the NASC TG20:13 Operational Guide);

» Click the green OK button when finished.

c_A_DS 8 Copyright 2024 © Computer and Design Services Limited
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Choosing the facade type

You can specify whether your scaffold is tied to a permeable fagcade (an open structure or a fagade
with a high percentage of openings) or an impermeable fagade (a solid building with few openings).

Facade
Type =

- Impermeable Fagade

E Permeable Fagade

» Click on the Fagade Type button;
» Choose the facade type that you require by clicking on your choice from the drop-down list;

» If you choose the permeable type (with openings) the fagade will be drawn transparently to
remind you that this option has been selected;

» Select each scaffold by hovering the burgundy square over the scaffold and then pressing the
left mouse button to apply the fagade to all your structures.

It is essential to use this option if your scaffold is tied to a building with a high percentage of
m openings, to ensure that your scaffold is built with sufficient ties.

Note that sheeted and debris-netted scaffolds must be designed if tied to a permeable fagade.

CA_DS 9 Copyright 2024 © Computer and Design Services Limited
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Specifying the scaffold loading

The TG20:13 check is greatly affected by the loading that your scaffold is required to
support.

By default, Check IT TG20:13 assumes that your scaffold will be a General Purpose
scaffold used for most types of building work. This is represented in Check IT TG20:13
by scaffolders on the loaded lifts.

You can change the working loads, to do this:

» Click the Loading button;
A General Purpose TG20:13 scaffold

» Click on the load class that you require; is loaded with 2.0 kN/m2 on one lift.

» Move and drop the scaffolder and weight icon that
appears, using the mouse left hand button, onto a lift. In most cases you will drop the load
onto the top lift of each elevation.

{ g%‘“":’ If you change the loading on the top lift, the 50% loaded lift is updated automatically.

% Very Light Loading (0.75 kN/m®)

% Light Loading (1.5 kN/m?)

é General-Purpose Loading (2 kN/m®)

M 8 s

% 50% Working Loads r
% Mot Loaded
Inside Boards are Fully Loaded This is now a Heavy Duty TG20 scaffold, loaded with 3.0 kN/mZ.

The scaffold load class has a great effect on the TG20:13 check, so be careful to select the correct one,
especially if you need heavy-duty loading. In particular the load class can determine the maximum
safe height of the scaffold, its maximum width, and the maximum distance between the standards.

Note that, regardless of the load class, TG20:13 requires that inside boards are only very lightly loaded
with a maximum load of 0.75 kN/m2.

c_A_DS 10 Copyright 2024 © Computer and Design Services Limited
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Checking for TG20:13 Compliance

After completing the above steps, you will be able to summarise your project for compliance.

Schedule T BIM Toalbox Model TT Check IT TG20:13 » Click on the TG20:13 Check

c\’ B EII button;

» The TG20:13 summary
Setsign-off SaveAs  Print . .
details report is displayed;

TG20:13

Sign File » To return to your model,
press the TG20:13 Check

button again;

Schedule IT BIM Toolbox Model IT Check IT TG20:13 > To print the report click on
7

the Print button.
||

> To save the report as a

Wind Factor Facade Loading Set sigh-off § Save As  Prin
- Type = - details PDF, select the Save As
TG20:13 Sign . button.

An example of a TG20:13 non-compliant summary report will look like this:

TG20:13 Summary Report 5= avast
Check details
Contract Number: Date:
0017 21-04-21
Site deteils
Site address: Surroundings: Wind factor:
XYZ Construction, Country 23.39
Council Offices,
Poale,
Newguay,
Cornwall,
TR8 4LE
Scatfolds which may require a design A
The followi ndscaﬂolda are NOT compliant with TG20:1 3|3nd design advice may be reguired.
Scaffold Advice
ltern 2: Free standing tower 1 The maximum working load excesds 2.0 kN/m?.
More than 1 lift is loaded.

No compliance certificates will be created for this scaffold.

§ g@":’ TG20:13 certificates require a Check IT TG20:13 Plus licence.

c_A_DS 11 Copyright 2024 © Computer and Design Services Limited
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An example of a TG20:13 compliant summary report will look like this:

TG20:13 Summary Report S

Check details

Contract Number: Date:
0017 21-04-21

Site details

Site address: Surroundings: Wind factor;
KYZ Construction, Country 23.39
Council Offices,

Poale,

MNewguay,

Cornwall,

TR8 4LE

Scaffolds which are complicmt

The following scaffolds are compliant with TG20:13 anl no design is required.lAII scaffolds must be constructed in accordance
with the TG20:13 Operational Guide.

Scaffold Maximum Design Maximum Foundation
working load  height tie duty leg load
(kN/m) (rm) (kM) (kN)

temn 1

Independent 1

+ Type: Unclad independent 2.00 4.00 0.98 8.1
' Maximum lift height: 2.00 m @
¥ Maximum width: 5 boards 16 m?

v Maximum bay length: 2.00 m
" Ledger braced
+ Tied at alternate lifts

The later pages will include one or more compliance certificates for this scaffold.

Independent scaffolding

i ragrs, s

Location
‘Sutae for 5588 Win 3 Winaaclor o 238
I eaarse s axceas, Sairg oy s,

Crteria

[ERr——
¥ Msmum fnegrt 20m; s st ena Tamss,
¥ Maimum o3y engn. 23 ¥ Dous e s aratos b 1 owoes s

¥ Mz o spasng: 1.2, ol pemites f )

¥ Eoemes atany rumosr o s,

SignOff
et
Compan:
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If your scaffold is not compliant with TG20:13, you will (if possible) be given advice about what you
could change to make your scaffold compliant.
Scaffold Advice
ltem 3: Independent 1 The maximum TG20:13 safe height has been exceeded.
You could consider the following options:

Add double standards to height 22m.
Change to tie pattern D or E and reduce the maximum bay spacing to 1.5m.

Here, | can see that | have three choices. | can add double standards up to 22 m, or | can switch to tie
pattern D (or E) and reduce the maximum bay spacing to 1.5 m.

See the Model IT User Guide available from the Help tab, for details of how to make either of these
changes.

CA_DS 13 Copyright 2024 © Computer and Design Services Limited
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Check IT TG20:13 user guide

Setting the signature details

You could print out the compliance summary report and certificates, and then sign them with a pen.
It may be easier to upload a picture of your signature and let SMART Estimator attach it automatically.

To do this, click the Set sign-off details button.

BIM Toolbox Model IT

File Schedule IT

details
TG20:13

A form is displayed:

Setsign-off JRave As

Check IT TG20: 13 I

Print

Sign-off details
My details

MASC membership number:  123456789012345678

Client {customer): ¥YZ Construction

Site reference (address):

My company: XY Z Construction _
My name: John Smith _
My job tile (position): Estimator
My signature: ; ? (e
Checker details
Checker name: Sam Tayloq

)/
Checker signature: P i

( y SO o

o Y e

Client and Site

¥¥Z Construction, Coundl Offices, Poole, Newguay, Cornwall, TRS 4LE

>

» To add your sighature graphic, choose Update (in the My Signature) section, and select the

image you want to use.

é%f’ Signed: W

My Signature is the only field used on the Summary Report.

Date: 21/04/2021

All of the others are only used on the compliance certificates.

CADS .
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Details to be used on the compliance certificates

The remaining details on this form, plus My Signature, are used in the sign-off section of the
compliance certificates:

Sign-Off
Contract no: 0017 __ Client: XYZConstruction
Company: XYZ Construction _ Scaffold reference: ltem 4: Independent1
NASC membership no (1):  123456789012345678 __ Site reference: XYZ Construction, Cornwall, TR8 4LE
Name: John Smith __ Signature: ; - ﬁ;

Position: Estimator _ Date: 21/04/2020
Checker Name: Sam Taylor __ Checker Signature: — -

(1) Use of this NASC document does not infer NASC membership. Go to www.nasec.org.uk to confirm membership. llustrations are indicative.
(2 The checker is responsible for reviewing the input information.

Fill out these details and choose Save Changes to update the compliance certificate.

These sign-off details are saved and used automatically for future projects.

The Reset buttons can be used to refresh the values from your My Address setting
and the projects Site Address.

-9

-
= Client and Site
=
Client (customer): XYZ Construction C' Reset
Site reference (address): XYZ Construction, Council Offices, Poole, Newquay, Cornwall, TR8 4.E c Reset

15 Copyright 2024 © Computer and Design Services Limited
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FAQ

Why is the Foundation leg load the same with double standards?

The Foundation leg load is the combined load for scaffolds with double standards.

Why does the TG20:13 summary report suggest reducing the maximum bay spacing for my non-
compliant scaffold when | already have double standards?

SMART Estimator assumes that a lower bay spacing is preferred to double standards, because this
usually requires fewer total standards.

e If you reduce the bay spacing as suggested, you can also remove the double standards. Your
scaffold will usually remain TG20:13 compliant.

e If you choose not to remove the double standards, following the remaining advice is usually
sufficient to achieve TG20:13 compliance.

Now TG20:21 is released, can we still work to TG20:13?

Yes. TG20:13 compliant scaffolds are exempt from design. However, TG20:21 is the latest guidance
for best practice. CADS recommend switching to Check IT TG20:21 if and when it is released. In the
meantime, we recommend using the NASC ePortal to access the latest guidance.

CA_DS 16 Copyright 2024 © Computer and Design Services Limited
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Using the other SMART Estimator products

The best way to use the SMART Estimator products is to use them together. Every product is designed
to enhance the rest of the suite.

SMART Estimator Check IT TG20:13 can be used with the rest of the SMART Estimator products:

SMART Estimator Model IT is a powerful 3D modelling tool. Use it to create scaffolds to exactly meet
your project-specific needs. It is recommended that Model IT is used alongside Check IT TG20:13 and
Check IT TG20:13 Plus, since you can use it to adjust the scaffold design so it passes TG20.

As a rapid way of creating large, multi-scaffold projects, Schedule IT can be used to rapidly create
scaffolding projects, which can then be checked for TG20:13 compliance.

Produce material lists and technical drawings alongside the TG20:13 compliance reports.
Produce a fast and highly customisable pricing report for your scaffolding project.
Generate quotations for the project, to send to the customer.

Create scaffolds more quickly, using information from an existing model, or export data from SMART
Estimator to be used in other design software.

N “’ For more information about the other SMART Estimator products, please refer to their
‘\i;, user guides, which are available from the Help tab.
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Feedback

Thank you for choosing SMART Estimator.

We are always striving to improve the product so please contact us with your feedback. We are always
keen to hear new ideas and if you experience any problems with the software we want to hear about
them so that they can be resolved.

. FRODULCT
h SUFFORT CENTRE
.

You can contact us via:

» Our website support centre at www.smartscaffolder.com/support.html;

» Email on support@smartscaffolder.com;

» Telephone on +44 (0)1202 603733 from Monday to Friday between 09:30 and 17:00.

CA_DS 18 Copyright 2024 © Computer and Design Services Limited
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